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Introduction 

Thank you for updating your TI-Nspire™ Navigator™ system to Version 3.2. 

These Release Notes are to help users who have been using TI‐Nspire Navigator update to the new TI‐
Nspire Navigator Teacher Software version 3.2.  Please make sure to update all of your TI‐Nspire 
products to the latest version to take full advantage of the newest features and enhancements and 
ensure compatibility between your handhelds and the TI-Nspire Navigator Teacher Software. We 
strongly recommend updating your desktop software prior to updating your handheld operating 
system. 
 
When you install version 3.2, you will get both the TI-Nspire Navigator Teacher Software as well as the 
TI-Nspire CAS Navigator Teacher Software.  These are separate applications.  You will be able to choose 
which application to use.  Your classroom rosters and portfolio information will be available in both 
applications, so you can use whichever one best fits with your lessons for that day. 
 

This document contains information that applies to the following products: 

 TI-Nspire™ Navigator™ Teacher Software 

 TI-Nspire™ CAS Navigator™ Teacher Software 

 TI-Nspire™ Navigator™ NC Teacher Software 

 TI-Nspire™ CAS Navigator™ NC Teacher Software 

Please also see the TI-Nspire version 3.2 Release Notes for information on new features available in 

TI-Nspire™ Teacher Software, TI-Nspire™ Student Software, and TI-Nspire™ Handheld Operating 

Systems.  
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1. Associating Your Wireless Clients to Your TI-Nspire Navigator System 
A new step has been added to the process of upgrading to TI-Nspire Navigator version 3.2.  You must 

also associate your TI-Nspire wireless clients (either your TI-Nspire Navigator Cradles or TI-Nspire CX 

Navigator Wireless Network Adapters) to you network before being able to run a TI-Nspire Navigator 

classroom session.  This step has been added to ensure that your wireless clients only connect to your 

TI-Nspire Navigator network (and not to another TI-Nspire Navigator network nearby).  In addition, you 

will now have the opportunity to name your TI-Nspire Navigator Network to make this association 

easier.  The steps to perform this process are as follows: 

 Update the TI-Nspire Navigator Teacher Software to version 3.2 

 Launch the TI-Nspire Navigator Teacher Software and make sure that your TI-Nspire Access 

Point is connected to your computer. 

 Open the Network Manager by selecting the Tools menu and then Network Manager. 

 Select the option to “Change Network Name”.  The Navigator Network Name dialog will appear.  

You can enter a name for your TI-Nspire Navigator network.  Choose a name that will be 

meaningful to you and your students, such as your room number (ex. “Room 117”).  The 

network name is tied to the TI-Nspire Navigator Access Point, so if you move from room to room 

with your TI-Nspire Navigator system, choose a name that will be meaningful in order to 

associate the wireless clients with this particular access point.  After entering a new name, press 

Continue.   

Note: your TI-Nspire Network name is displayed in the Network Manager window.  If you choose 

not to change your network name, you will be choosing to use the default network name. 
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 Attach the wireless clients to the TI-Nspire handhelds. 

 Using your TI-Nspire Navigator system or TI-Nspire Docking Stations, transfer the TI-Nspire 

handheld operating system version 3.2 to your handhelds.  After receiving the new operating 

system, the TI-Nspire handhelds will re-boot as usual to install the new OS. 

Before you can conduct a TI-Nspire Navigator classroom session using the TI-Nspire version 3.2 system, 

you will need to identify the network that you want your wireless clients to connect to.  You can do this 

immediately after the re-boot process (assuming your handhelds are connected to a wireless client and 

are within range of your TI-Nspire Navigator Access Point) or you can do this the first time your students 

log in to the TI-Nspire Navigator class session. 

If you wish to select the TI-Nspire Navigator network immediately after updating the OS, you can do so 

from the new dialog box that appears before the Home screen is displayed.  In addition to selecting the 

language and the font size for the handheld, you will see a dialog for selecting the TI-Nspire Navigator 

network.  If no wireless client is attached to the handheld, you will not see this dialog. 

If you prefer to have your students identify the TI-Nspire Navigator network the first time they log in 

after the OS upgrade, they can do when they access the Login dialog box on the handheld.  If no network 

has been selected yet, the first time the TI-Nspire Navigator login dialog is displayed, you will need to 

identify a network.  Select the Network button and choose the preferred network name from the list 

displayed in the drop down menu.  The student can log in to your Navigator session as usual after 

selecting the network. 

 
TI-Nspire Navigator network name dialog box 

showing a custom network name 

 
TI-Nspire Navigator network name dialog box 

showing the default network name 
 

Note: This is a one-time selection.  It ensures that this wireless client will connect to the preferred 

network and no other TI-Nspire Navigator networks within range.  After selecting a preferred network, 

you will not have to do this process again unless you wish to connect to a different TI-Nspire Access 

Point. 

  



 
 

 
TI-Nspire™ Navigator™ Version 3.2            

Release Notes                                                                           6           

 

2. New Question Types 
Version 3.2 of TI-Nspire Navigator includes new questions types that you can create.  The new question 

types are Expression Question, Image Question, and Chemistry Question.  Each new question type is 

described in this section. 

2.1 Expression Question 

The Expression Question type accepts a response that is either a general Expression or a Number.  

Once you have inserted the Expression Question, you can choose which response type to accept.  By 

default, the question allows a general expression, but you can narrow the accepted response to a 

number by selecting “Number” from the Response Type drop down menu in the Configuration Panel 

(located in the Documents Toolbox under the Document Tools tab). 

You can configure how to automatically grade an 

expression question 

 Expression Response – Provides the ability to 

enter one or multiple accepted expression 

responses.  You can also choose whether to 

accept equivalent expression responses as 

correct.  The option to accept equivalent 

responses as correct is checked by default.  

This means that if you indicate the correct 

answer is     , then equivalent responses 

     and        will automatically be 

graded correct.  You can always mark a 

student response incorrect in either the 

Review Workspace or the Portfolio 

Workspace. 

 Number Response – Provides the ability to 

specify a single number as a correct answer 

along with a window of tolerance for correct 

answers.  When this question type gets 

graded, any equivalent response that falls 

within the window of tolerance will be graded 

as a correct answer. 

It’s worth noting that the equivalence setting in the configuration panel makes a difference to the 

student experience depending on whether students are using TI-Nspire or TI-Nspire CAS handhelds 

or Student Software.  When students using TI-Nspire CAS check the answer to an expression 

question by selecting Check Answer, they will see that their response is correct if it is equivalent to 

the correct response you (the question author) provided. If you indicated the correct response is 



 
 

 
TI-Nspire™ Navigator™ Version 3.2            

Release Notes                                                                           7           

 

     and the student responds      , they will see that their response is correct because the 

TI-Nspire CAS handheld is able to compute equivalence involving variables.  However, TI-Nspire 

(numeric, not CAS) is unable to compute equivalence involving variable responses. Because it cannot 

compute equivalence involving variables, TI-Nspire (non-CAS) handhelds and Student Software will 

simply reveal the correct answer and let the student know that equivalent responses are correct.   

2.2 Image Question 

There are two types of Image Questions that can be inserted: Label or Point On.  Each type allows 

you to insert an image as part of the question.  The specifics of each option are described below. 

 Label – The Label option for the Image Question allows you to insert an image to be 

included in the question and ask your students to enter labels on it.  Students are able to 

enter text as well as math print and chemical notation in the labels.  When this question is 

inserted, there is by default one label inserted.  You can add labels by adjusting the Number 

of Responses in the dialog in the Configuration Panel.  You can also resize and move the 

labels anywhere on the image. 

 Point On – The Point On option for the Image Question allows you to add Radio Buttons (for 

single response) or Check Boxes (for multiple responses) to an image.  You can add multiple 

response fields and place them anywhere on the image. 

 

 
Image Question: Label  

 
Image Question: Point On  

 

2.3 Chemistry Question 

The Chemistry Question automatically converts the student response to Chemical Notation.  

Students do not have to format subscripts and superscripts, as the formatting will adjust based on a 

simple set of rules.  For example, if the student enters CaCO3, the 3 will be automatically formatted 

as a subscript. Superscripts may be entered by selecting the ^ key before the sign and value of a 

charge.  If the student enters PO4^3-, it will be formatted as PO4
3-. When entering a chemical 

equation, the + key will separate two reactants or products, and the = key will result in the insertion 

of a “yields” symbol.   
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Chemistry Question with Chemical Equation 

Answer 

 
Chemistry Question with Answer 

 

Any student response is marked correct if it is an 
exact text match to any accepted response. Any 
student response is considered incorrect if it is not 
an exact text match to any accepted response.  You 
can enter reactions written in different orders of 
reactants and products to make sure that student 
responses are graded appropriately. 
 
Note:  The Chem Box is a helper to enter chemical 
equations; it doesn’t have symbol recognition 
capability. So if you are trying to type the formula for 
carbon monoxide, it will not automatically know that 
you mean CO as opposed to Co (Cobalt.).   
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3. Grading and Viewing Individual Documents 
Grading of student assignments has changed to allow for addition flexibility in determining the final 

score for the student. While the Total Points Column and Raw Score are auto-calculated by the Portfolio 

you can modify the student’s score in two new ways: 

- Add additional points by modifying the value in the +Points column (note: leaving the Total 

Possible value for the column as zero will treat the points you give to the student as extra 

credit.)  

- Change the overall score by modifying the value in the Final Score column 

 

In addition the Portfolio Workspace has also been updated to allow you not only to see the scores for 

your students but to view the question, correct answer and student answer for each question in the 

document. To view a student’s 

specific response select the 

assignment you wish to view in the 

Assignments Panel, and then select 

the student and question you want 

to view. From here you can choose 

to assign credit to the student by 

double clicking in the cell and 

updating the value.  
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4. Exporting Student Data from the Portfolio Workspace 
You can now export student scores from single or multiple assignments that have been saved in the 

Portfolio Workspace to a CSV (Comma Separated Values) file.  This file can then be imported into a 

grade book system or other student information system. 

You have two options for how to export the data from the Portfolio Workspace; you can export 

everything in the portfolio or you can choose which assignments to export.  To access the Export Data 

feature, make sure you are in the Portfolio Workspace and do one of the following: 

 Open the File menu and select Export Data 

 Locate the Export Data icon  on the toolbar and select it 

To export all assignments from the portfolio to a CSV file, choose the option to Export Current View.  A 

dialog box will appear and you will be asked to name the file and choose a location to save it. 

To export select assignments from the portfolio to a CSV file, choose the option for Custom Export.  A 

dialog box will appear showing all of the assignments that are saved in the portfolio.  Check the box next 

to the assignment name(s) you wish to export and choose Export.  At this point you will be asked to 

name the file and specify a location to save it. 
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5. Managing TI-Nspire Navigator Classes 
There is a new method to help you easily manage classes that you create from year-to-year.  If you have 

used TI-Nspire Navigator Teacher Software for multiple years, you may have classes from previous years 

in your list of classes.  The example below shows that there are classes from 2010, 2011, and 2012 all 

listed within the Class drop down menu. 

 
Class list with classes from multiple years 

 
Manage Classes dialog box 

  

The list of classes can become cumbersome if you only need access to your current classes for the 

semester/year.  In version 3.2, you can now go to the Class Workspace and select the Class menu.  You 

will see an option called Manage Classes.  Select this option and the Manage Classes dialog box will 

appear.  This dialog allows you to Hide any classes that you no longer wish to see in your Class drop 

down menu but that you are not ready to delete.  You can also choose to Delete any class from the list.  

The Delete operation will permanently delete the selected class(es) and all data associated with them.   

Note:  Deleting a class is a permanent operation and cannot be undone, so be certain that you do not 

need any data from any class that you choose to Delete. 

6. Opening Transferred Documents 
When you send a document to your students with the  

TI-Navigator system version 3.2 (both the TI-Nspire 

Navigator Teacher Software and the TI-Nspire handheld OS 

or TI-Nspire Student Software must be version 3.2), your 

students will experience a new option upon receiving the 

document.  They will be prompted with a choice to Open 

the document that was just received, Go To the location of 

the document or Cancel and dismiss the dialog.  This new 

feature makes it easier for your students to get to the 

document that was just received and saves you time in 

class. 
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When multiple files are sent with a single Send Document action, the files are sent in a queue to the 

handheld device in alphabetical order.  

 If the Open option is selected the last file in the queue will open by default.   

 If the Go To option is selected the last file in the queue will be highlighted in the Document 

Browser. 

If a document, other than the last document in queue should be opened, the student will need to select 

it in the My Document Browser. 

7. Content Workspace Updates 

7.1 Ability to View All File Types in Content Workspace 

The Content Workspace has been updated so that you can now view any file type within the 

Content window.  Previously, only TI-Nspire related documents (e.g. *.tns, *.tnsp, *.edc, *.tilb, etc) 

appeared in this window.  If you prefer to continue to only see TI-Nspire documents, the Filter By 

option in the View menu can be set to Show TI-Nspire™ Content Only.  As with previous versions of 

TI-Nspire Navigator, you can select and send files directly from this Workspace. This update will be 

very helpful for users of TI-Nspire Navigator for Networked Computers who wish to send file types 

other than TI-Nspire files to their students.   

 

  



 
 

 
TI-Nspire™ Navigator™ Version 3.2            

Release Notes                                                                           13           

 

7.2 Access Files Stored on Network and Removable Drives 

You can also now view and access files that are stored on Network or Removable Drives (such as 

USB thumb drives) within the Content Workspace.  Any Network drive or Removable drive that is 

currently mapped to or connected to your computer will show up alongside your local disk in the 

left-hand pane.  The image below shows the removable drive, “THUMBDRIVE”, along with the 

contents of its Algebra Files folder (notice that you can view all file types on network and removable 

drives as well). 

 


